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Preface 

Dear User： 

Thanks for you to buy GeneTest series of Thermal Cycler! When you use this product, please be sure to 

carefully read the instruction manual, and you should keep. 

You can become our customers is our great honor. To help you quickly grasp GeneTest series of Thermal 

Cycler instrument to use, we have prepared a statement for you. Our product specification strive to be 

comprehensive but concise presentation. From which you can obtain the device characteristics, operating 

instructions and maintenance aspects of knowledge. We strongly recommend that you use this product before, 

be sure to carefully read, this will help you make better use of the apparatus. If your request fails to manual 

operation of apparatus for any loss resulting, according to the relevant provisions of Division I will not be liable. 

Thank you for your cooperation! 
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Chapter Ⅰ:Safety Guidelines 

1. Safety warnings and note that language tips 

High temperature warning: The instrument affixed with a heat warning marked regional and  

described in this manual do not hand the direct high temperature zone in the region, in order to  

avoid burn! 

 

Electric shocks Warning: Be sure to shock warning information in strict accordance with the  

requirements of the implementation of operations, in order to avoid electric shock accidents! 

 

Note: Note that prompted the phrase that contains the information of particular importance, be 

sure to read them carefully.If the failure to do so may cause equipment prompted not work, and  

even damage to equipment! 

 

2. Safe to use 

In using this instrument, please read the following, be sure to comply with the following basic security measures. 

If you do not comply with these measures or other places in this manual that warning, it may affect the normal use 

of the instrument, and even damage to equipment, injured personnel. 

1). Prohibited equipment placed in humid, dusty, high temperature, magnetic environment of use. 

2). Open the cabinet against unauthorized or the items touch the apparatus with the internal components. 

3). Prohibition of anything to plug vents, beware of gloves or rags into the outlet at the bottom of inhalation 

equipment. 

4). To keep equipment clean, and timely maintenance. 

   Note: The encounter the following situations, the power plug immediately unplug from the power 

 outlet, and contact with suppliers rectified. 

1). Instrument through the rain, irrigated or liquid penetration. 

2). Equipment not working properly, in particular, there is any unusual sound or smell there. 

3). Instrument function changed significantly. 
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Chapter Ⅱ: Installation 

2.1 Package Content Verification 

When you receive my company's GT-based PCR instrument, please check out of the box include the following: 

① Instrument                  1  

② Power line (single-phase 3-wire)             1  

③ Spare fuse（8A ，250V）                  2  

④ Operation manual                    1  

⑤ Simple operation manual        1  

If not match, keep the original box, and timely contact with us. 

2.2 Use of the environment 

1). Indoor use。 

2). Temperature 5℃-35℃。 

3). Relative Humidity 10%—90% 

4). Should stay away from heat sources to avoid liquid penetration inside the instrument。 

5). Equipment shall not block the sides and bottom vents, instrument 30CM distance on both sides shall not place 

any other items to ensure the smooth ventilation equipment. 

 

2.3 Power supply 

The instrument uses switching power supply suitable for a wide voltage range, 85-264V AC voltage can be 

between the normal working frequency is 50 ~ 60HZ, power cord for the single-phase three-wire, grounding must 

be reliable. 

Warning: Instrument must be reliable and grounded to avoid electric shock accidents! 
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Chapter Ⅲ: Instrument Features 

3.1 Overview 

PCR thermal cycler instrument (also known as gene amplification, or PCR amplification instrument instrument) is 

a polymerase chain reaction (Polymerase chain Reaction) referred to as PCR technology, a new instrument 

designed. PCR was guided by a pair of primers able to specific genes in plants and animals in vitro (DNA) 

fragments for rapid enzymatic amplification technology. PCR thermal cycler for the qualitative or quantitative 

PCR test provides a high-temperature template denaturation, primer annealing temperature, proper temperature 

primer extension are three important temperature conditions, while elevating the temperature with a fast and 

accurate temperature control, temperature field uniformity, and high level of automation , this instrument can not 

be directly applied to clinical. 

Scope: Suitable for molecular biology, medicine, food industry, forensic science, biotechnology, environmental 

science, microbiology, clinical diagnosis, epidemiology, genetics, gene chip, genetic testing, gene cloning, gene 

expression in areas such as polymerase chain reaction (Ploymerase Chain Reaction, PCR) for the feature to detect 

the DNA / RNA for the purpose of a variety of pathogen detection and genetic analysis. 

Gradient PCR instrument addition to the standard PCR instrument with the above-mentioned functions, the 

gradient module is also available at the same time as many as 12 different annealing temperature of PCR reaction, 

in the gradient module can be realized on the gradient of temperature and gradient parameters such as adjustment 

of the width of the free programming 12 temperature gradient annealing temperature to achieve different samples 

and at the same time thermal cycling. Only a single experiment will be able to identify a particular system of the 

corresponding optimal annealing temperature. This will result in a short time on the optimization of PCR 

experiments, greatly enhanced the efficiency of PCR research. 

The following describes the structure of this instrument, keyboard and various function keys, the initial use of this 

instrument, please read carefully. 
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3.1.1 Instrument Construction 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Cover                      2. Host               3. Vent 

4. Instrument feet        5. Vent                    6. Nameplate  

7. RS232 port                  8. USB port                    9. The power switch  

10. Power outlet                11. Fuse holder                  12. Air inlet 

13. Vent                      14. Vent                   15. Knob 

16. Button                   17. Display screen                  18. Keyboard 

 

3.1.2 Keyboard 

 

 

1. Control keys 

2. Multi-function keys 

3. Direction keys 

4. Number keys 

5. Display 

  

  

11  

22  

33  44  
55  

77  66  

1100  

88  

1122  
1111  

99  

1133  

1144  

1166  

1177  

1155  

1188  
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3.1.3 Key Note 

          Numeric input, character input 

 

                     Temperature, time increment / decrement editing the sign switch 

                               

                

                         Clear key, backspace 

 

 

                         Exit file editing or return on a menu 

                         To cancel the operation or clear the alarm dialog 

 

                         The file name input switching the case of letters 

                         Hybrid module or switching module 384 displays the gradient 

 

                         Run File 

                         Stop File 

                       

 

 |                    Multi-function key 

 

 

                         Select menu, the file 

                         Moving the cursor 

                  

 

                         To enter the menu 

                         To confirm the operation 
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3.2 Feature of this instrument 

1). The most advanced peltier-based semiconductor technology. 

2). High-performance universal power supply. 

3). Large 5.7-inch high-definition LCD display. 

4). Bilingual curve graphical interface.  

5). Power-down data protection. 

6). Metal shell, solid, practical, beautiful and generous. 

7). Stepless adjustable Lid can adapt to different heights in vitro. 

8). Lid can be positioned at any angle. 

9). High sealing reaction zone to ensure stable and reliable experiment. 

 

3.3 Performance 

 

Model GT9611/9631/5421/3841  

General 

GT9612/9632/5422/3842  

Gradient 

 Capacity 96×0.2ml , 96×0.2ml+77×0.5ml , 54×0.5ml , 
384well 

 Temperature Range 0～99.9℃ 

 Heating Rate 4℃/s 

 Cooling Rate 3℃/s 

 Uniformity ≤±0.3℃  

 Accuracy ≤±0.2℃  

 Display Resolution 0.1℃ 

 Temperature Control Block\Tube 
 Ramping Rate Adjustale 0.1～2.5℃ 

 Gradient Uniformity / ≤±0.3℃  

Gradient Accuracy / ≤±0.2℃ 

 Gradient Temp. Range / 30～99.9℃ 

 Gradient Spread / 1～30℃ 

 Hot Lid Temperature 30～110℃ 

 Hot Lid Height Adjustale Stepless Adjustable  
 Number of Programs 200  
 Max.No.of Segment 9 
 Max.No.of Step 9 
 Max.No.of Cycle 99 
 Time Increment/Decrement 1 Sec ～ 9 Min 59 Sec 

 Temp. Increment/Decrement 0.1～9.9℃ 

 Pause Funcation  Yes 
 Auto Data Protection  Yes 
 Graphical Display  Yes 

 Hold at 4℃ Forever 

 Language Chinese/English 
 LCD 5.7inch，320×240 pels 

 Communication USB2.0 , RS232 
 Dimensions 392mm×262mm×252mm (L×W×H) 

 Weight 10kg 
 Power Supply 85～264VAC , 50～60Hz , 600 W 
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Chapter Ⅵ: Instructions 

4.1 Power on 

1). Power 

The back of the instrument connected to power cord into an electrical outlet, and the power supply switch set "-." 

Power equipment, the buzzer will issue a "beep" sound, LCD screen lit, LCD screen displays the product name, 

company LOGO, name, URL, and software version number, instrument into the self-test status, self-test standby 

interface after the end of as shown below. 

   

   Power Interface            Standby Interface 

2). Preheat 

Devices in standby mode, warm plate and lid. If you need to change the lid preheat mode, please see "4.5 Hot Lid". 

The default lid preheat mode is the “Hot lid on when power on”, lid preheating temperature of 105 ℃. 

3). Open cover 

   

 

 

 

 

 

 

 

Hold down the button opening the cover and then turn up (as shown in Figure 1), and open to a suitable height (as 

shown in Figure 2). Lid can be positioned at any angle of orientation（0°--95°）。 

 

 

 

Button 

Plate 

Lid 

Seal 

Figure 2 Figure 1 
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Warning: After power on, do not hand direct contact with plate and Lid heating region, careful  

burn! 

 

4). Adjust to hot lid height 

This series of instruments hot lid parts of the human design, by regulating the compatible 0.2ul, 0.5ul, 384well 

different specifications of test tubes, to meet the requirement of experiment. 

 

 

 

 

 

 

 

 

 

 

This series of instruments knob adjustment are as follows: counterclockwise rotation, hot lid moving upward; 

clockwise rotation, hot lid downward drop. 

 

Knob 

 

Knob 

Hot lid up Hot lid down 
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4.2 Menu structure 

File

Help

Recond

Set

Lid

Main-Menu

Grad

New

Edit

Delete

View

Rename

Temp up/down rate

Low temp preserve

Temp control mode

Date&time

Sound

Language

 
 

4.3 File System 

File is PCR program, File composed by Temperature Segment and Cycle Step, each File can contain up to 

nine Temperature Segment, each Temperature Segment can contain up to nine Cycle Step, the maximum 

number of Cycles is 99 times. Cycle Step contained Set Temperature, Cycle Time, Gradient Width 

(GT-XXX1 type without this), Temperature Increment and Time Increment. 
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Example1: File structure 

94℃     4m20s 

94℃     35s 

55℃     45s     35 Times 

72℃     50s 

72℃     3m30s 

From the above PCR program, we know that this File is structured as follows: 

File contains 3 Temperature Segment； 

The first Temperature Segment contains 1 Cycle Step，the Cycles Number is 1； 

94℃     4m20s 

The second Temperature Segment contains 3 Cycle Step，the Cycles Number is 35； 

94℃     35s 

55℃     45s     35 Times 

72℃     50s 

The third Temperature Segment contains 1 Cycle Step，the Cycles Number is 1； 

72℃     3m30s 

 

4.3.1 New File 

In the standby interface, select the File menu, press "Enter" key to enter the “File list” interface, the following 

picture: 

      

1). The file name input and set the temperature segment 

In the “File list” interface, press “F1 (New)” key to enter the “New file>Segment&step” interface. First, press 

number keys, direction keys and “Enter” key input file name. After the completion of the file name, press "Enter" 

key to set the temperature segment, see "Example 1: File structure ", set the following picture: 

press "Enter" key 

  

日
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2). Cycle parameter 

If the file name input and temperature segment set up are completed, then press "F5 (Next)" to enter the “New 

file> Cycle Parameter” interface, press number keys and direction keys enter the appropriate content, the following 

picture: 

      

3). Option menu 

In the “New file> Cycle Parameter” interface, press "F2 (Option)" key, instead of confining the Options menu, 

Options menu contains the “Gradient” (GTXXX1 type does not include this), “Temp Inc”, “Time Inc” of three 

projects. 

A. Gradient 

Gradient in the options menu, select items, press "Enter" key after the cycle of steps in the corresponding gradient 

of the width is set to display items, press the number keys enter the desired value, and the curve of the bottom hole 

temperature of each column shows the value of the following picture. 

      

B. Temperature increment 

In the Options menu, press "↑" "↓" keys to select the temperature increment item, press "Enter" key after the cycle 

The completion of 

the file name input 

And press "Enter" 

key 

Press the number 

keys and direction 

keys 

Press "Enter" key, 

and enter the width 

of the gradient 
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of steps in the corresponding temperature increments within the display items, press the number keys enter the 

desired value, the following picture. 

      

C. Time increment 

In the Options menu, press "↑" "↓" key to choose the time increment item, press "Enter" key after the cycle of steps 

in the corresponding time increment is set to display items, press the number keys enter the desired value, the 

following picture. 

      

4). Add / Del menu 

In the “New file> Cycle Parameter” interface, press "F1 (Add / Del)" key, jump out of the Add / Del menu, Add / 

Del menu contains “Add Segment(L)”, “Add Segment(R)”, “Add Setp(L)”, “Add Setp(R)”, “Del Segment”, “Del 

Setp” these six items can be arbitrarily change the temperature segment and Cycle Step, the following picture. 

 

5). Save the file 

All input has been completed, press "F3 (Done)" key to save the new file, and return to the “List file” interface. 

Press "Enter" key, 

and enter the 

temperature 

increments 

Press "Enter" key, 

and enter the time 

increment 
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4.3.2 Edit File 

In the “File list” interface, press "F2 (Edit)" key to enter “Edit file” interface, you can arbitrarily modify the file 

contents, methods of operation with the new file, this manual will not detail in this. edit complete , press "F3 

(Done)" key, will be saved out of Edit menu, which contains “Save As” and “Save” items, if you choose to “Save” 

item, then cover the original file, if you choose “Save As” item, you need to enter a new file name. 

4.3.3 Delete File 

In the “File list” interface, press "↑" "↓" key to select to delete the file, and press "F3 (Delete)" key, the interface 

will be out of question in the dialog box, press "Enter" key to confirm you can delete the file. In order to prevent 

files mistakenly deleted, the system only supports a single operation can only remove a single file. 

4.3.4 Preview File 

In the “File list” interface, press "↑" "↓" key to select preview of the file, and press "F4 (View)" key or press 

"Enter" key, you can preview of the file contents. 

4.3.5 Rename 

In the “File list” interface, press "↑" "↓" key to select to rename the file, and press "F5 (Rename)" key, the interface 

will pop rename input box, enter the desired file name. 

4.3.6 Run File 

In the “File list” interface, press "↑" "↓" key to select to run the file, and press "Run / Stop" key, the interface will 

be out of question in the dialog box, press "Enter" key to confirm to run the file, enter the run file interface, the 

following picture. 

 

1). Operating system interface to display information 

The current file name, the current plate temperature, the current hot-lid temperature, run time, the remaining time, 

current temperature steps, cycles, cycle time, and the file part of the curve. 

2). View Files 

To view the entire file, you can press "F3 (View File)" key to see. 
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3). Pause 

To pause the file, you can press "F5 (Pause)" key to pause the file and restore run by "F4 (Resume)" key. 

4). Stop Files 

To stop the file, you can click "Run / Stop" key, the interface will be out of question in the dialog box, press 

"Enter" key to confirm you can stop the file, and return to the list of files interface. 

 

4.4 Settings Menu 

In the standby interface by "→" key to select setting item, then press "Enter" key to enter the “Setting” menu. 

      

Set the menu containing the “Temp Rate”, “Temp Ctrl”, “Hold Low Temp”, “Time/Date”, “Sound” and “language” 

which is set six items, press the direction keys to move the cursor, press "Enter" key to enter the settings required 

for entry. 

4.4.1 Variable-temperature Rate 

Press "↑" "↓" key to select the heating rate and cooling rate items, press the number keys to change the heating rate 

and cooling rate values. Press "F5 (default)" restore the default value, the default maximum cooling rate. 

4.4.2 Temperature Control Mode 

Temperature control mode is divided into the “Block Temp control mode” and the “Tube Temp control mode”, the 

general PCR experiment, use the “Block Temp control mode”, in the high-demand situations, select the “Tube 

Temp control mode”. System default is the “Block Temp control mode”. 

4.4.3 Hold Low Temperature 

If this function is enabled, System will automatically “hold low temperature” after the end of program, protect the 

sample will not degenerate. System, this function is enabled by default. 

4.4.4 Time and Date 

Set the system time and date. 

4.4.5 Sound 

Press "Enter" key  
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“Keyboard sound”, “Alarm sound”, “File end sound” and “Temperature to reach sound” opening and closing 

settings. System default “Keyboard sound”, “Alarm sound”, “File end sound” three sounds open, the “Temperature 

to reach sound” off. 

4.4.6 Language 

Native support for the bilingual system, this setting items can switch languages. 

 

4.5 Hot Lid 

Hot lid temperature setting range is 30 ~ 110 ℃.Hot lid has four work mode, “Hot lid off”, “Hot lid on when 

power on”, “Hot lid on when file running”, “File start run when hot lid reached set point”. System default hot lid 

temperature is 105 ℃, hot lid work mode is the “Hot lid on when power on”. 

 

4.6 Gradient Calculator 

Simply enter the core temperature and gradient width, you get the hole temperature of each column. Different 

types of instruments are the corresponding gradient calculator (GTXXX1 type does not include this). 

 

4.7 Record 

Record each run file name, run time, the file was created, and record the total number of experiments. Can record 

up to 200 test information, excess, the most old records are removed. 

 

4.8 Help 

Introducing the machine features and simple instructions. 
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Chapter Ⅴ: Maintenance  

5.1 Instrument maintenance 

1) . Regular cleaning 

A. Neutral soap solution should be used to clean the cavity above the plate. (To avoid the use of alkali, 

concentrated alcohol and organic solvent solution) 

B. Should be maintained below the plane and its left and right vent no other items, the instrument in use for some 

time after the adhesion of some of the dust vent will be cleared in time, it is very important. 

C. Plate should be kept clean, the plate once the deposit accumulation inside the cavities of some reactant residues, 

will affect the temperature response, it is recommended to use cotton scrub on a regular basis. 

2)．Replacement fuse 

The instrument equipped with two fuses, once damaged, can be found in the following steps to replace. 

A. Power switch set "0" bit, remove the power cord. 

B. Fuse holder with a screwdriver in groove by rotating the direction of the arrow, pull out the fuse. 

C. Remove after two 8 A 250V fuse, if damaged, replaced, and then re-insert the fuse holder, and then the word 

screwdriver according to fuse seat in the opposite direction of the arrows rotate, the installation back in situ. 

Note: If a replacement fuse later it still fails, please notify the company responsible for  

maintenance. 

 

5.2 Inspection and failure to exclude 

1). The results of poor response 

In response to this machine, and ultimately did not receive the desired results, the problem may be in biology, 

the program or hardware device, in order to help to distinguish between hardware failure, the machine is installed 

for the self-test hardware and software for self-diagnosis , the following will be described in detail, according to 

our experience, usually most of the problems of biology and procedural matters, common faults are as follows: 

A. Response items wrong, or insufficient quantity or purity of poor or trace amounts of single-core strand is not 

correct. 

B. Denaturation temperature is too high or too low, in this machine, it is recommended to use 90-95 ℃, for 40 

seconds, according to the number of responses may be a corresponding increase or decrease the amount of time. 

C. "Annealing" temperature too high or too low, should be 55-70 ℃, 20 Dao 30 aliphatic suitable. 



Operation manual of GeneTest series  

 18 

D. Reactant concentration is too high or too low. 

E. Preparation process, without special treatment. Should be at 70 ℃, mineral oil processing. 

F. Program time and temperature values inappropriate. 

G. Sample temperature is slightly lower, while the module temperature is slightly higher. 

H. Check the reaction tube is placed well, can be a little mineral oil coating with holes, in order to increase thermal 

conductivity. 

2). The machine self-test and self-diagnosis Function 

Boot operation, the chance to run the self-test procedures, test instrumentation software and hardware and displays 

the results. In order to notify the user of potential problems as soon as possible, to minimize the experiment fails. 

And in the event of failure to display an error message. 

 

5.3 Notes 

1). Power 

A. The power of this machine is no special requirement, the use of wide range, AC 85V-264V, but the power 

supply voltage fluctuations can not be too large, so as to avoid damage to machines, devices, or installing power 

supply should be considered. 

B. The machine in the process of running the program, the ban on cutting off the end of the power of the method of 

experiment for two reasons: 

First, the implementation of procedures for the negative; 

Second, the power cut off, fans stop switch, component cooling impeded, easy to plot 

heat damage. 

2)．LCD Display 

The machine should avoid the use of ultraviolet disinfection, to prevent the destruction of LCD liquid crystal 

display, use the process, should avoid rigid objects, knocking, scratching, to avoid damage. 

3). Cleaning Precautions 

When you clean the machine base, should avoid entering the liquid inside the machine, you are doing the 

experiment, probably added with radioactive substances, should be extra careful in the washing. The machine 

should not be in the wet, exposure of the environment. 

Note: Please read the contents of this section notes that if the failure to operate the above  
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requirements, it may cause equipment damage! 

5.4 Error message and corresponding countermeasures 

No. Error message Possible causes and corresponding 

countermeasures 

1 File is empty, create a new file! Instrument for the first time the use or the file is cleared, 

the new files. 

2 Step cycle is zero, please enter the number 

of cycles the steps! 

Do not enter the number of cycles the steps to complete 

the input. 

3 Cycle time is zero, please complete the time 

to edit! 

Cycle time can not be zero, enter the date and schedule. 

4 File name can not be empty! File name does not support the null character. 

5 File name too long! File name maximum support 8 characters. 

6 File storage is full, please delete the old 

files! 

The maximum file storage capacity of 200, exceeding the 

alarm after. 

7 Have the same file name the file, rename! Is not supported with the same file names multiple files. 

8 Beyond the gradient temperature range, 

please re-enter! 

Set the width of the gradient, the top or bottom of the 

temperature range of super. 

9 File is corrupted, delete! Non-interference with the normal power failure or severe 

damage caused by file data. 

10 Sensor short-circuit the left side of the 

module! 

Hardware failure, need to overhaul. 

11 The left side of the module sensor open! Hardware failure, need to overhaul. 

12 Central Module Sensor short-circuit! Hardware failure, need to overhaul. 

13 Central module sensor open! Hardware failure, need to overhaul. 

14 The right side of the module sensor 

short-circuit! 

Hardware failure, need to overhaul. 

15 The right side of the module sensor open! Hardware failure, need to overhaul. 

16 Radiator Sensor short-circuit! Hardware failure, need to overhaul. 

17 Radiator Sensors Open! Hardware failure, need to overhaul. 

18 Lid sensor short circuit! Hardware failure, need to overhaul. 

19 Lid sensor open! Hardware failure, need to overhaul. 

20 Power output short-circuit! Hardware failure, need to overhaul. 

21 The module temperature is too high! Blocking vents or circuit failure, if the latter needs repair. 

22 The module temperature is too low! The ambient temperature is too low, or circuit failure, if 

the latter needs repair. 

23 Heat sink temperature is too high! Vent blockage or fan failure, if the latter needs repair. 

24 Heat sink temperature is too low! The ambient temperature is too low, or circuit failure, if 

the latter needs repair. 

25 Hot lid temperature is too high! Circuit failure, need to overhaul. 
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5.5 Instrument abnormal causes and corresponding countermeasures 

No. Fault Description Possible causes and corresponding 

countermeasures 

1 Instrument power no display after boot Make sure the power cable properly inserted into the 

socket, check the power output, to confirm whether there 

is electricity, plug in the off pulling equipment, testing 

fuse. 

2 After the power is turned on, the plane 

began its work in the program among 

Before the end of the last run, power was interrupted。 

3 Fan with strengths and weaknesses Normal. Fan is only used to heat the heat pump work, is 

not used to achieve the set temperature. 

4 Instruments work, making a slight clatter 

sound or squeak 

Normal. Need high-power intense heat or strong cold, the 

machine beat clatter sound or squeak issue oscillation 

switching power supply automatically adjusts the sound. 

5 Very slow heating and cooling modules See variable temperature setting and fan speed is normal 

operation. 

6 Dislocation appears on LCD screen Due to power surges caused by electrostatic pulse or the 

display of dislocation, please re-boot after power failure 

does not affect the program runs. 

 

Note: If the above method does not resolve the problem, please contact the vendor! 
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Chapter Ⅵ: Service 

1. Equipment warranty for two years, the warranty period if the user fails under normal use, I Division is 

responsible for free repair. 

2. Lifelong maintenance, we are located in the local dealer, repair stations, the Office can provide you with 

considerate after-sales service. 

3. The following conditions shall not even in the warranty period, free repair, replacement and returned. 

   1). Due to fires, earthquakes, floods, storms, lightning and other natural disasters and abnormal voltages, 

pollution, chemical erosion and damage caused by Russia's failure. 

   2). Adverse conditions (fumes, dust, moisture, direct sunlight, etc.), the use, or fails the requirements of this 

manual use, maintenance caused the failure or damage. 

   3). As the fall, move, transport, entry of foreign matter or products manufactured by the company causes such 

as failure or damage.
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AppendixⅠ  Model code rule table 

No. Code Description Remark 

1 GT Products series abbreviation GeneTest 

2 96 , 54 , 384 Plate number of holes 384 blocks the last one into the 

number 3 

3 1 0.2ml Tube capacity 

 2 0.5ml  

 3 0.2ml&0.5ml  

4 1  General  

 2  Gradient  

GT 96 1 2

1

2

3

4

Product Series

Plate number of holes

Plate type

Gradient
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AppendixⅡ Warranty 

Origin  Model Production Number 

User Name Telephone 

Address Postcode 

Vendor 

Name Postcode 

Vendor 

Seal 

Address Telephone 

Sale Date       Invoice number 

Maintenance 

records 

Carry-in 

date 

Repair 

tickets 

Number 

Fault 

conditions 

Cause of the 

malfunction 

Disposition Produce for 

examination 

dates 

Repairer 

Signature 

       

       

       

Note: The above content altered invalid. Repair ticket numbers should be consistent with the number of repair 

receipts, maintenance records of the documents in order to repair the norm. Please save repair bills to inspection. 


